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Tutorial 2

Creating A New Project
Using HEW

Renesas Technology America Inc.



Overview

This tutorial describes the steps in creating new projects for
the M16C using two different methods.

The first method uses the SKP project generator, that will
create an empty project.

The second method will provide step by step instructions on
creating a project with existing source files.

To get the most out of the SKP including the development
tools, check out the references at the end of this tutorial.

Note: This tutorial assumes the user has done the following:

1. Followed the ‘Quickstart Guide’

2. Installed the SKP files, examples, and software tools in the default directories.
3. Reviewed Tutorial 1.
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Starting HEW

PrintFolders k

QuickTime »

Fﬁ Renesas * | l@ High-performance Embedded Workshop 3.1 # f@ Manuals 4

Sprint » @ On-ine Support r
_ WInRAR r @ Todls r

Eﬁ! High-performance Embedded Workshop

B8 Manuals Browser

{E] Register on-ine

From the Windows Start menu, click on
Programs > Renesas > High-performance Embedded Workshop 3.1
> High-performance Embedded Workshop
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£ High-performance Embedded

File Edit Wiew Project Options Build  Memory  Tools

Workshop
Window  Help

M=1E3

Nedd|& s iTu||oF|D|/E@Scng 2|2

JJ Eﬁ IuEsmr4

|[nzas(lecass] =

HaeBE||ans g

ETELErEL & & O

/"
1. Ensure
this option
IS selected.

plions:

¢ Create a new project workspace

" Open arecent project workspace;

@ IE:'\HEW?'\TutDrE_ngT Ltarz . po. b ;I

=

E‘ " Browse to another project workspace

ok

#I 2. Click on
JEREERE ‘OK’ button.

@ Projects EI Templates | Mawigation

x|
i

‘ AT+ T\ Rash } Build £ Debug  Findin Fles } ‘Version Control f

Ready

| | | ] O 7

When HEW starts up, you will be prompted to select a workspace. By
default, ‘Create a new project workspace’ option is selected.
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Creating a New Project with the
SKP project generator (1/4)

o Paiect wrkspace
Frojects |
3. Enter ‘Tutor2_pg'.
@ Application Wworkspace Mame: / —pg
2 Select E Empty &pplication IT'-‘t':'Q_F'Q A
. |I'!'I|:lI:Irt b ak efile Preject Name:
‘ M 1 6C/62 F\ g "Ei:?_-'F' Starter Kit Plus ITutDrE_pg
Starter Kit I%:"f:mw;ﬂ : |
SHew3WTutorz_pg Erovze. ..
Plus’ as the :
. CPU famil 1. Select M16C.
project type. -
T oal chair:
IFienesas M1EC Standard j\4 Verlfy RenesaS
M16C Standard is
o ' Properties. .. | SelleCted )
Note: This is the directory where [ o ] ceea |

the project will be created,
‘C:\HEW3\Tutor2 _pg'.

/

5. Click on ‘OK’ button.
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Creating a New Project with the
SKP project generator (2/4)

M16C/62P Starter Kit Plus - Step 1 |

wWwhat bupe of praject do vau want ta
generate’?
£ Werifp SKP

These projects allows you to verify the
SEF and the development environment

" Sample Code

Shanamare 1. Seledt
‘Empty Project’.

g ‘Empty Project |

Setz up and initializes the M16C/AEZFP faor
thiz SKP

2. Click on ‘Next’
/ button.

< Back | Mest > | Einizh | Cancel I |

Note: The other project selections (Verify SKP and Sample Code) allow you to
test the SKP and evaluate the MCU peripherals and features using pre-built
sample code.
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Creating a New Project with the
SKP project generator (3/4)

M16C/62P Starter Kit Plus - Step 2 |

The follawing files will be added ta the

project:
File I Dezcrption |
defaultzession. haf HEW Seszio...
main_B2pzkp_templa..  kain zounce .
noitl_62pskp.a3l Startup code. .
readme. bt Readme text...
zectI0_B2pskp.inc Section and ..
#frB2p.k SFR definitia...
zfr_B2p a3l SFR Definitin...
skp_bzp.h b acroz for th...
skp_lod.c Funchions for. ..
zkp_lcd h Header File f..
. (= y
/1 . Click on ‘Finish

/ button.

7

< Back | [ et I Einizh | Cancel |

Note: Step 2 shows all the files that will be added to the new
project and their description.
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Creating a New Project with the
SKP project generator (4/4)

Project generator information |

The project will be generated with the following specification:

CPU information:
CPU = M1BC

Additional files:
defaultzezzion. hef
main_BZ2pskp_template. o
nortl_62pskp a3l
readme. kst
zectd0_BZ2pzkpinc
#HrE2p.h
zfr_B2p.a3d
zkp_bzp.h
gskp_lod.c
zskp_lod b

1. Click on ‘OK’ button.

The project generator information is shown once the project
has been created.
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HEW after Creating a New Project using the
SKP project generator

Eﬁi EmptyProject - High-performance Embedded Workshop

File Edt Yiew Proect Options Buld Memaory Tools Window Help
Nede &Pl ra||vga==]Eu e 2=l % & %
i B e [ o [ 5| [DefautGession HasEr||aaessa

wf|[ERERERER

=
Bl
E'@ EmptyProject
1429 Agsembly source file
o ie[E] netD_E2pskp.a3n
=23 C source file
main_E2pszkp_template.c
E1-23 Dependencies
----- zect30_E2pskpinc
- shf2p.h
- skp_bzp.h
= skp_led h

_-Epmjem @Templ... I €|Na\riga... I

Lelx

T
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SKP project generator
Summary (1/2)

The following is a summary of what happens when creating a new project
using the SKP project generator Empty Project:

1. The following files are created in the workspace or project directory (in this
example, under C:\Hew3\Tutor2_pg):
= A copy of the user startup (ncrt0_62pskp.a30 and sect30_62pskp.inc)
files.
= A .cfile (main_62pskp template.c) that contains the main function.
= Copies of the SKP header files (sfr62p.h, skp_bsp.h, and skp_lcd.h)
included in the .c file.
= A copy of the sfr62p_labels.a30 file so SFR labels are visible in KD30.
2. Links the startup files first as shown in the “Linking the startup files first” slides
(slides 25 & 26).
3. Configures the external debugger to launch KD30 as shown in the “Launching
KD30 from HEW” slide (slide 28).
4. Adds the phase to generate a hex file when building a project as shown in the
slide “Generate a hex file for the Programmer” (slide 29).

10 LENESAS




SKP project generator
Summary (2/2)

EX Tutor? _pg

The project structure
and files created
when using the SKP
project generator are
shown here.

File Edit “iew Favortez Tools

Help

s Back ~ = - | ‘) Search

L4 Folders @|E’ qg » tﬁl|'

Address | Tutor? pg j o Go
Falders * || Mame Size | Type - |
7] BOOTDISK =] |0 debug File Folder
D Cadence nertl_62pskp.a30 EKE  A30File
{1" DISCOVER zf_B2p.a3d 13KE  A30File
E-@ Posuriiils arid Settirigs main_62pskp_tem.. 1KE CFile
w7 DRIVERS skp_led.c 4KB CFile
B flesdrn sfiEZp.h 1EKE HFile
E-C3 Hew? skp_bsp.h 4KB HFile
w7 ADC 05 skp_ledh 3KB H File
-C3 ADC.Repeat defaultsession hsf 2KB  HSF File
H-0 ETC TutorZ_pg. hwp 16 KE  HWwWP File
D help @ zect3]_62pskp.inc 13EE  IMCFile
-0 Manuals @ Azgemblyincludefil... 3KB  SHLFile
D skptest @ Azzemblylistile. shl 3kB SHLFile
F-C System a Azzemblyzourcefile. . 3KE SHLFile
=0 Tutor?_pg ] Cheaderfile. shl 3KB SHLFile
525 fe )] Clistfile. shi 3KB SHLFie
i E a Configurationfile. shl 3FKB  SHL File
=-7 1386 a Csourcefile. shl 3KB  SHLFile
-0 MTOOL ] Default shi 1KB SHLFile
D Mulimedia Files @ editardefault. zhl 1KB SHLFile
D ORCADWIM || [#] Hexfile.shi 1KB SHLFile
D Frogram Files a Linkagermapfile.shl 1kKEBE SHLFile
BT SONYSYS @ PreprocessedCsou... 3KB  SHLFile
{:I TEMP a S-Recordfile.zhl 1KE SHLFile
D WINNT % readme. b 1KE  TextDocum..
=2 rsewille? (D) -] |4 | i
25 object(s) [Disk free space: 210 GB) 193 KE A My Computer 4
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Creating a New Project Environment

The SKP project generator simplifies several steps in creating a
new project but what if you already have source files? The
following slides will walk you through the following:

 Creating a new workspace from scratch

« Adding source files

» Setting up the software development environment including
linker, build, debugger, and programming configuration.
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Creating a New Project (1/8)

Select ‘New Workspace’ from the File menu...

Prajects
1A SeIIIeC;[_ q I o /4. Enter ‘Tutor?’
pplication’. (e t=— Fruoz as name of the
St i project.
Tutar?
2. Browse to, or enter, Diestory S5.leave as s
‘C\MTOOL\SKP1 6C62P/'I:HMTEIEILHSKFWEEEEF‘HSampIe_EDdeHTutDrIZ Browse... | (|.e. ‘TUtOI’Z,).
, CPL farnily: !
\Sample_Code’. [m16C o «—3. Select M16C.
T ool chain: 1]

IFienesas b16C Standard

Jd~— 6. Select Renesas
M16C Standard is

Properties. .. | SelleCted
; ak. I Cancel |‘

7. Click on ‘OK’ button.
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Creating a New Project (2/8)

Mew Project-1/6-5elect Target CPU.Toolchain verzion |

o 1. Leave as is.
Toolchain wersion ;
[5.3.0.0.et j’/

Which CPL do wou want bo uge for this
project?

CPU Series:; _ 2 Select
| M16C/60.

MI1BCA0
RACTiny

CPU Tope:

Cther

If there iz no CPU type to be zelected,
zelect the "CPU Type" that a similar to
hardware specification or zelect "Other'’.

¢ Back | M et > I Finizh | Cancel

3. Click on ‘Next’ button.
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Creating a New Project (3/8)

Hew Project-2/6-5elect RTOS

N Se— 1. Select 'M16C/60'.
;TQS: Ir‘u:une ;I"_— 2 Leave aS iS
— 3. Select ‘USER.

Startup file type :
Startup files ;
El@ Project l‘.}l

a C zource file
43 T header file fdd
a Azzembly source file 53
a Azzembly inchude fle u
4= Configuration file Remove

4. Click on ‘Next’ button.

ﬂf ‘L‘- :
[ Show file path

< Back | MHext > Finizh | Cancel |

Note: 1. Differences between Default and USER Startup files is
discussed after the project is created.

iEEﬂE - 15 RENESAS




Creating a New Project (4/8)

Mew Project-3/6-5etting the Contentz of Files to be Generated

W Wwhat kind of initialization routine
would you like to create’?

I Use 40 Libramy

¥ UseHeap Memnany 1 . SeleCt ‘None, aS We
e B . already have a file
Ge el with the main()

function.

< Back | N’e:-:w I Finizh Cancel

2. Click on ‘Next’ button.
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Creating a New Project (5/8)

The stack settings are grayed out because USER startup file was
selected (see Creating a New Project 3/8 ). If DEFAULT startup
file was selected, these settings become available.

Mew Project-4/6-5etting the Stack Area |

What are the stack settings?

= Uzer Stack Panter

Stack Size;
Q3004

I Rtermupt Stack Fointer;

Stack Size:
03004

/ 1. Click on ‘Next’ button.

Finizh | Cancel |

Ll

|
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Creating a New Project (6/8)

™ Targets:
Mo items

_1. Select ‘none’.
(we set this up later)

— External Debugger ;

FM1EC Family k0304 3.20 Releaze 16

T arget type I J

. |m4|/.:l |

2. Click on ‘Next’.
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Creating a New Project (7/8)

We already have the source files and selected USER startup files
(see Creating a New Project 3/8 and 4/8 ) and so, there are no
source files that will be generated.

The following source files will be
geherated:

File Namel Eut... | Dezcription

1. Click on ‘Finish’

to complete project
J | | creation process...

< Back I i F=t Finizh | Cancel |

LENESAS
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Creating a New Project (8/8)

A project summary is displayed to indicate a successful creation of

the new project, tutor2.

Summary 2]
Project Surmmary:
-------- PROJECT GEMERATOR -------- -~

PROJECT MAME :
PROJECT DIRECTORY :
CFU SERIES :

CPU TYPE :
TOOLCHAIM MAME
TOOLCHAIN YERSIOM :
GEWERATIOM FILES :

+]

Tutor2

CAMTOOLMSEPTECE2PAS ample_
b16CARD

Other

Renezaz M1BC Standard Toolcha

5.200

DATE & TIME : 11/542003 7:56:12 P

Click DK to generate the project or Cancel to abort.

[ Generate Readme.tst as a surmmany file in the pro

r

directany

Cancel |

e

20

1. Click on ‘OK’.
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HEW

After creating the project, HEW will look similar to the figure below.

'5"2- Tutor2 - High-performance Embedded Workshop

Do C|Dsmteee | e [ o 8 4G

NEE

r——— @ "ms 1"
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Default and User (SKP) Startup Files

Except for comments, the differences between the default (ncrt0.a30 and
sect30.inc) and user (ncrt0_62pskp.a30 and sect30 _62pskp.inc) startup files
are listed below:

Ncrt0.a30

= BCLK - Set to f1 (div by 1) of Xin (BCLK = Xin frequency) in user file.

= Stack sizes — Smaller (0x100) in user file [default at 0x300].

= Heap size — 0 (no heap size) in user file.

= Vector Base Address — 0xFDO00O for (M16C/62P) in user file [default at
OxFFDO00 (M16C/62)]

= Section Allocation — Calls user sect30 file (sect30 _62pskp.inc) [default
calls default sect30.inc].

= Standard /O Initialization — No initialization in user file (done using
mcu_init from main()) [default file calls _init routine].

Sect30.inc
= Variable Vector Definition — Simplified and described in user file

Note: You can use the default startup files but ensure that you understand the how to

make the necessary modifications. The customized startup files for the SKP can

2 LENESAS

be found under C:\MTOOL\SKP16C62P\Sample_Code\Startup_files directory.



Adding Source Files (1/2)

1. From HEW’s Project menu, select Add Files and the Add Files dialog box is
displayed.

2] ]
o T deBgE 2. Browse to C:\MTOOL

- \SKP16C62P
\Sample_Code\Tutor2_src
folder, which contains the
3. Select main_tutor2.c source codes for this

and ncrt0_tutor2.a30. tutorial.

% Acrkll bk 2 &30
sect30_tutors inc

— 4. Click on Add.

File name: I"main_tutl:urE.c" kot tutor2,a 30" &dd
Filez of type: IF'ru:uieu:t Filez j Canizel |
[T Relative Path

o
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Adding Source Files (2/2)

After adding source files, HEW’s workspace will look like the figure below.

1. To display dependencies per source file, right-
click on the Workspace window, and click on the

“\

i
Cancel |

N

2. Click on check boxes in
Configure View dialog box.
3. Click on OK button.

Displaying the source file
dependencies this way makes
it easier to verify if the header
files are included before
building the project.

x|
BR=] o2
E][E? Tutor2
E| a Agzembly zource file . .
Pohe . nertd_tutar2. 230 Conflgure VIeW.
EI a C =zource file
. main_tutor2.c Configure Yiew
EI a Dependencies
. sect30_tutor?.inc ¥ Show dependencies under each file
¥ Show standard library includes
[ Show file paths
@ijecix @Templates @:lNa'u'igaﬁnn
=l
- II!HHEI
=- EE; Tutor2
El 'a Azzembly zource file
CoE- . nertd_tutor2, &30
P e [E] secti0_tutorZing  —
=B 'a C source file 7
= I. rnam buborZ.c
- sfrEEp h /
..... Sk.l:l bgp h }
o skplcdh
@ijectx @Templates @:lNa'u'igaﬁnn
24
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Linking the Startup File First (1/2)

After checking dependencies, NC30 must be setup to compile and link the startup
files first. The startup files contain information on memory addresses and sections
which the linker uses to place the code at the correct addresses.

1. Select Renesas M16C
Standard Toolchain from

the Option menuand

this window is displayed.

2. Select All
Configurations.

Renesas M16C Standard Toolchain

Configuration ;

I.-’-'-.II Configurations

-

= All Loaded Frojects
=- e

- C zource file

[:I Agzembly source file

3. Click on Link tab.
d

C I Azzembly  Link |Li|:|rarian| Lre I LCfg I A [ ¥

Categony : I Input j

Show entries for

)Helncatable files j

Irzert... |

4. Select [ s |
Relocatable 5.Click on Add.  #]| ¢]
files. e Down
[-E] Specifies start addrezs
af abzolute maodule : I
Optionz Link :
L ne30lib -G -MS -0 =l
$CONFIGDIR]WEPROJECTMAME] x30
1] |+ =
k. | Cancel |
25 LENESAS




Linking the Startup File First (2/2)

1. Select Configuration

directory.

2. Enter the Startup I Inn::rtEI_tutn:an

source file, i.e.

nert0_tutor2.

-

Add relocatable file

Belative ta

2 x]

\ IEaniguratiDn directary

Eile path

j Cancel |

T~

3. Click on OK.

Configuration ;

I.-’-'-.II Configurations

E"@ Al Loaded Projects
=-[E Tutor2
-0 C source file
Ela Agzembly source file
----- ncrtd_tutorZ. a3

2 x|
C I fizzembly  Link |Li|:|rarian| L I Cfg I Mﬂ_’l
Cateqony : IInput j
Show entries for ;
I Relocatable files j
FICOMFIGDIRMnerd_tubor2.r30 add...
Inzert... |
Bemoyve |
2| ¢
Up Do
[-E] Specifies start address
of absolute module : I
O ptions Link, ;
-L ne30ib -G -5 -0
FCONFIGDIR M HPROJECTMARME]. 430 /
I

Cancel |

26

=1 |+ 4. Click on OK.
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Defining an Include Directory

For this SKP, files that are common to all the sample code are kept in a directory
named “\Common” under \Sample_Code. An example is the register definition file
sfr.h that is included for all the projects, yet never needs to be modified. Because
of this, we will need to setup up in HEW how to instruct the compiler where to look
for these files during compile time.

[ "‘“é ﬂg 1. Select Renesas M16C Standard
Configuration : ssembly | Lin ibrarian | Lmc g L4 . .
— G [l 2 14 Toolchain from the Options menu
= @ Aland Dicts Show entries for : and thiS Window is displayed'
I@ II il Include file directories ﬂ

+-[[] Assembly source file | - [4] Specifies the directory cantaining the filels) specified in
finclude. You can specify up to 8 directories :

2. Click the Add... button.

Add include file directory

ez ] 3. Set the “Relative to:” option to

BRelative ta:
Lztann director - ancel llil =
= ey Custom directory and the
|C:'\MTDDL'\SKF"IEEB2F"\SampIe_C0de'\common Browse... SRR “Directory:” to the Iocation Of
) alil your Common directory for your

ok | Cancel | SKP.
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Building (compile & link) the Program

El"E!TuturZ High-performance Embedded Workzhop
File Edit “iew Project Optione Buld Memon Tool: Window Help
Icseg|g|sza|loTal|lor D|e|E || oy [BLC
|7l A7 ||| @ & ||| @ e & [[poovo |7
=R EE - \
=l
= R —
= I@ Tutor?
=- a Azzembly zource file
B . hiertd_tutar2. 530
B 5] secta0_tutor? inc
Ela C source file
=[] main_tutor2 =
- sf2p.h
----- zkp_bzp.h
- skp_led b
N @ijectx @Templates @:lNa'u'igaﬁnn
2|phase MI6C Linker finished - ;l
- .— Look at the Output window and check
Build Finished .
0 Errorz, 0 Warnings Whether any errors OI‘ Wal‘nlngS occurred. j
mauiluﬁ, Debg . FidnFRa  Vemonotrd f
Ready | [ [ N5 | | v

If there are no errors, try running the program on the SKP16C62P Board using the

ICD and KD30 Debugger.
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1.

2.
3.

6.

Launching KD30 from HEW

KD30 can be launched directly from HEW, but HEW must be
configured as shown below.

Select Customize from

from the Tools menu.

Click on Debugger tab — Ertermal debugger selected:

Select Other external
debugger.
Locate KD30 from

C:\MTOOL\KD30 folder.

Enter -LOAD=$

(CONFIGDIR)\$(PROJECT

NAME).x30.
Click on OK. —

To launch (and download .x30
file) KD30, click on this icon.

Tn:u:nll:narsl En:nmmandsl Mery | Placabetders® Debugger I Laog I Help I
IEIther external debugger j
— Debugger settings

External debugger location:

iE:RMTDDL'\KDSD'\KDED.EKE | 3 | Browsze. . |

Command line options:

/I-LEI.f-‘-.D=$[EEINFIGDIH]W[F‘HDJEETN.&.ME].:-:3[1 | 3 |
Download module;
I }l Browse. .. |
e
—> | oK |

mﬂmmm

29
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Generate a hex file for the Programmer

After building a program, a file with an .x30 is generated. For this example,
‘tutor2.x30’ is generated. This .x30 file can be downloaded using

KD30. However, device programmers, including the FOUSB

Programmer, use hex files in Motorola or Intel format.

1.To generate a hex file Build Order | Build File Order | File Mappings |
during the build process, N
select Build Phases from [IM1EL C Compilr Add... |
. W[t 1EC Azzembler
the Optlon menu- [WM1EC Linker Modify. .. |
#1EC Stype Corverter
/ M1 Liarin ﬂl
. [IM1BC Configurator e |
2. CI'Ck on M16C Stype DM1EEJumpgtaI:|Ie Compozer Herals
b ove Down
converter checkbox. HoveDow |
« | ] Imnpaort... |
3. Click on OK. [ ok ] cance |

With the feature enabled, a hex (.mot) file is created when building the project.
Look for a Tutor2.mot file under C:\MTOOL\SKP16C62P\Sample_Code\Tutor2\

Tutor2\Debug’ folder.
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End of Tutorial 2

This is the end of the tutorial. You can try modifying or
downloading other sample programs from the
\Sample_Code directory.

The completely built tutor2 project can be found in the

Zip file under C:\MTOOL\Sample Code\tutor2_src
folder.

Be sure to check out the references on the following
pages.

Have Fun!!
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References and Recommended Reading

All documents that came with the SKP can be found using the “Document
Description” from the Start > Programs > Renesas-Tools > SKP16C62P
menu.

« SKP16C62P User’s Manual: This document provides on the Starter Kit.

« HEW User’s Manual: To fully understand and get the most out of HEW. This
iIs recommended reading.

« KD30 Version X.XX Help: The tutorial only covered the basics of KD30.
Check out the Help menu to find out all of KD30’s features.

« NC30 Version X.XX User’s Manual: Check this manual out for features
specific to the NC30 compiler.

« M16C/62P Hardware Manual: M16C/62P device specification.

 RTA-FoUSB-MON User’s Manual: Provides details on the In-Circuit
Debugger and Flash over USB Programmer.
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References and Recommended Reading

« M16C/10/20/60 Series C Language Programming Manual: This is a great
document for any level of programmer. The first chapter is an introduction and
reference on the C language. The next chapter explains specifics of C
programming with the M16C microcontroller.

« M16C/10/20/60 Series Software Manual: This document describes the
instruction set and timing information for the M16C/20/60 series CPU cores.

« AS30 Version X.XX User’s Manual: Read this manual if you plan on writing
programs in Assembly or when making changes to the startup file.

- Application Notes and Sample Programs: Application notes and other
sample programs can be accessed from Renesas Technology America’s
website: hitp://www.renesas.com.

PLATFORM Gm
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